Digital Billboard Content Guidelines

Content Design Recommendations
OBJECTIVE

To provide effective content (also referred to as digital artwork or digital advertisements) by using good design practices as they relate to digital outdoor displays and/or digital billboards.

When you have hundreds of thousands of dollars worth of cutting-edge technology as your very own advertising medium, you don’t want to waste its capabilities. Effective content is absolutely critical for your digital display to bring about the sales lift you expect.

We know that the content of the message is very important: it must be relevant to the customer, brief, and to the point. But in addition to good content, the display message must be produced in an attractive and entertaining manner.

To achieve our objective, we must understand the following:

WHAT IS LED DIGITAL OUTDOOR AND/OR DIGITAL BILLBOARD?
A digital billboard display, sometimes referred to as LED digital outdoor advertising or a combination of these words, uses an array of light-emitting diodes (LEDs) to show computer-programmed images and text, which are easily changed and updated using Visiconn™ Display Management Solution Web-based software.

WHAT IS DAY PARTING?
In order to achieve maximum advertising flexibility and return on investment, a display should take advantage of day parting. A day-parted schedule advertises time-sensitive promotions at the time they are valid and target specific demographics at the time they will see the billboard. With a properly scheduled Daktronics digital billboard working with Visiconn™ Display Management Solution, the marketing possibilities are endless.

WHAT IS BEST FOR THE ARTWORK/CONTENT FOR DIGITAL DISPLAYS?
The artwork/content created for LED digital billboards should be approached differently than artwork created for magazine/newspaper advertisements or television commercials. The content on a digital display must not only be vivid and use contrast properly, it must be brief to be effective.

Traditional signage and advertising has one chance to convey all necessary information to customers. A digital billboard, on the other hand, can display multiple messages that appeal and inform customers of products and services.
BREAKING IT DOWN


Though digital billboards show an ad for approximately 7 to 10 seconds, those that are most effective should be “devoured” in three seconds. Build the message based on the three-second rule. Narrow the focus and decide what your message will be. Make it concise. The message can be one of the following:

- A person
- A national brand
- A Web site
- A service
- A call to action
- A location
- A product
- A price
- An event
- A local brand
- A special promotion
- A specific time: Morning, Noon or Evening

EFFECTIVE

- Placement of the car moves the eye naturally to the information.
- Excellent use of color contributes to the legibility.
- Fewer design elements clarify the message.
- Web site encourages consumer to take action.

INEFFECTIVE

- Too many design elements compete for visual importance.
- Too much color confuses the customer.
- Poor car placement does not encourage the eye’s natural flow.
- The local brand (Miles) and national brand (Chevrolet) are buried in the text.

GRAPHIC DESIGNERS SOLVE VISUAL CREATIVE PROBLEMS USING THESE BASIC PRINCIPLES.

The information in this guide will help you understand the use of these three basic design principles for creating digital display content that wins the glance and entices your client’s customers.

1. COMPOSITION
2. TYPOGRAPHY
3. COLOR
**DEFINE LAYOUT**

Layout is the design principle that determines the finished look of an advertisement. The most important principle for creating effective outdoor content is visual prioritization of the message, or hierarchy of communication. Consumers can’t hear and understand four messages at once; they can’t see and understand four messages at once, either. Define the items (ABC levels) you want to communicate and prioritize each piece in order of importance according to the following information.

People read in chunks of information. They scan across, then down, and pick up information in logical sections. The more distinct those sections of information, the faster people interpret the meaning or the purpose of the message. Visual and written information that overlap cause the reader to pause and sort the two apart before understanding the message. Using hierarchy of communication helps speed comprehension and increases retention of the message.

Tip

Ask your audience to take action, such as “Call Today.”
Hierarchical Communication:

Use the levels as guidelines to first capture the viewer’s attention with a clear, single point of communication. Then give the viewer definition or detail that points back to the first level. Finally, give them the information they need to inspire an emotion, an action, or a purchase.

Level A: A photo, logo, service, product image or price. Whichever is the most important piece of information.

Level B: Supporting information that gives definition or detail to support level A.

Level C: Relevant information that tells the customer where, how or who to contact for the information in levels A and B.

Traditional vs. Digital Advertising

Some worry they will not be able to get all of their information on one frame or piece of artwork. So they add every possible detail they can think of. This mindset derives from traditional print advertising.
Digital Billboard Site Content Guidelines

DESIGN PRINCIPLE 2
TYPOGRAPHY

DEFINE TYPOGRAPHY
Typography is the arrangement and appearance of type on a page.

READABILITY
Select easy-to-read typefaces. Large, bold fonts make it easier for your audience to read and comprehend text from different viewing distances. In addition, text using all capital letters is harder to read. Use text made up of both upper- and lower-case letters.

EXAMPLE:
This Text Is Easier to Read from Far Away
THIS TEXT IS HARDER TO READ FROM FAR AWAY

SELECTING EFFECTIVE FONTS
Select fonts that are easy to read from different viewing distances, such as large, bold fonts. Remember to use text containing both upper and lower-case characters when you have a long message. Using text with all caps should be limited to short messages. Using a limited amount of text will help viewers’ readability and comprehension. Examples of these variations on text are to the right.

Tip
When possible, after creating the ad, look at the content on the actual digital billboard display to make sure it’s easy to read.
MAKE IT A CAMPAIGN
Digital advertising needs to be created differently than traditional print magazine/newspaper advertising because of the unique capabilities of the medium. Print advertising has one chance to convey all necessary information to customers, whereas digital advertising can show several messages in a series of rotations giving advertisers multiple chances to convey the necessary information to customers.

Daktronics’ VisiconnSM Display Management Solution allows multiple clients to advertise separately on a digital billboard. The web-based software easily updates and automatically rotates through a series of individual clients’ digital advertisement slots. The slot belonging to one advertiser may also have unique digital content showing at each rotation. This provides a better chance to attract the attention of different demographics and promotes campaigns of ads with small amounts of text (i.e. information) instead of a single text heavy advertisement (see ineffective design image below).

Below is a campaign of digital advertisements for a zoo with each ad containing similar design characteristics. The information is broken into five separate ads, making it easier for viewers to comprehend on a digital billboard rotation.

**Tip**
When using a colored background, outlining the letters in black and using drop shadows can create interest and increase readability.
DEsign principle 3
COLOR

Define Color
Take full advantage of your display’s color capability by using rich, vibrant colors. Bright, saturated colors (colors with no white in them) work better than pastel or low-contrast colors.

Certain colors tend to evoke specific emotions or ideas, so choose them carefully to help support products and ideas. See chart below.

The color wheel to the right features a full color range.

Colors and the emotions they evoke

<table>
<thead>
<tr>
<th>Color</th>
<th>Emotions Evoked</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Stimulating, exciting, provocative, dynamic</td>
</tr>
<tr>
<td>Red Orange</td>
<td>Domination, aggression, and action</td>
</tr>
<tr>
<td>Orange</td>
<td>Friendly, vital, playful, energizing, inviting</td>
</tr>
<tr>
<td>Yellow Orange</td>
<td>Illumination, wisdom, and wealth</td>
</tr>
<tr>
<td>Yellow</td>
<td>Sunny, warming, cheerful</td>
</tr>
<tr>
<td>Yellow Green</td>
<td>Sickness, cowardice, discord, and jealousy</td>
</tr>
<tr>
<td>Green</td>
<td>Soothing, nature, refreshing, healing, fresh</td>
</tr>
<tr>
<td>Blue Green</td>
<td>Emotional healing and protection</td>
</tr>
<tr>
<td>Blue</td>
<td>Cool, quiet, serene, constant</td>
</tr>
<tr>
<td>Blue Violet</td>
<td>Uniqueness, preciousness, royalty, and sacredness</td>
</tr>
<tr>
<td>Violet</td>
<td>Creative, regal, spiritual, mysterious</td>
</tr>
<tr>
<td>Red Violet</td>
<td>Energetic, happy, sweet, romantic, youthful</td>
</tr>
<tr>
<td>Black</td>
<td>Strong, classic, elegant, mysterious</td>
</tr>
</tbody>
</table>
USE TONAL CONTRAST

Using contrast is vital to your design because it helps the viewer distinguish between design elements. For best contrast, use tonal contrast (or value difference) instead of only color difference.

Tonal contrast can be measured by using compositing software such as Adobe® Photoshop®. Simply open your advertisement using your preferred compositing software and then convert it to gray scale. You can now easily measure the advertisement’s tonal contrast. An example of this is shown on the right.

MEASURING TONAL CONTRAST

The bottom image uses hues of red and green that have the same tonal value (bad contrast). It is difficult to distinguish between background and text. This produces an effect called “vibrating.” After converting content to gray scale with compositing software, the advertisement’s tonal contrast is apparent.

Examples of good tonal contrast in digital outdoor content.
After turning your content to gray scale, is your advertisement still readable? Do all of your elements stand out? If so, your content piece has good tonal contrast.

Good Tonal Contrast
USING CONTRASTING COLORS

Select colors that provide good contrast to make your content more appealing and easier to read. Achieve effective contrast by using colors with different values (how bright or dark a color is).

Use the chart at the right to guide your design. You can see that yellow is a bright color with a very light-gray value. Purple, on the other hand, is a dark color with a black value. Therefore, using yellow and purple together provides very good contrast.

By looking at the chart again, you can see that yellow and green aren’t the best colors to use together because the contrast between the two is so low. Solve this problem by using a darker green that has a darker value to increase contrast and readability.

The value range chart on this page shows you how each color (in this example we used red) has a number of values to choose from. This makes contrast easy to achieve.

**GOOD CONTRAST LIKE THIS MAKES YOUR CONTENT HIGHLY VIEWABLE.**

---

**In a Few Seconds**

Remember the product user must be able to see the artwork, scan for details, and make an assessment of the data. Do not overwhelm them with visual clutter.

**Tip**

Choose a color or graphic that supports your essential message. In this case, blue implies cool or cold and orange is inviting and energizing; just what you need in the morning.
**White Backgrounds:**

_Avoid white backgrounds._ With LED technology, the use of emitted light, white or very light colors may repel the eye—not the desired response in advertising. A grave concern in most regulatory environments is offensive use of light or white content. Even though Daktronics digital displays are fully capable of producing white and pastel colors it is not recommended. Taking advantage of the color capabilities is thoughtful and in general more pleasing to the eye. If white or pastels must be used, the content should only be scheduled for daytime viewing.

**Black Backgrounds:**

For digital billboards, black is the absence of color. Black is created with the use of less light. White is the blending of all colors and the use of more light in digital billboards.
STANDARD COLORS
MAKE YOUR DIGITAL CONTENT POP WITH COLORS THAT WORK

Find information below about the RGB (red, green and blue) colors that look the best on a digital display. Choose these colors when building digital content/artwork/advertisements to take advantage of the full-color capabilities of your cutting-edge Daktronics digital billboard.

TRUE COLORS:

<table>
<thead>
<tr>
<th>Color</th>
<th>R</th>
<th>G</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>255</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Green</td>
<td>0</td>
<td>255</td>
<td>0</td>
</tr>
<tr>
<td>Blue</td>
<td>0</td>
<td>0</td>
<td>255</td>
</tr>
<tr>
<td>Yellow</td>
<td>254</td>
<td>233</td>
<td>0</td>
</tr>
<tr>
<td>Orange</td>
<td>255</td>
<td>88</td>
<td>0</td>
</tr>
<tr>
<td>Purple</td>
<td>182</td>
<td>52</td>
<td>187</td>
</tr>
</tbody>
</table>

OTHER COLORS:

<table>
<thead>
<tr>
<th>Color</th>
<th>R</th>
<th>G</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow</td>
<td>255</td>
<td>182</td>
<td>15</td>
</tr>
<tr>
<td>Orange</td>
<td>255</td>
<td>161</td>
<td>0</td>
</tr>
<tr>
<td>Sunshine</td>
<td>252</td>
<td>217</td>
<td>0</td>
</tr>
<tr>
<td>Red Orange</td>
<td>255</td>
<td>121</td>
<td>0</td>
</tr>
<tr>
<td>Coral</td>
<td>255</td>
<td>109</td>
<td>88</td>
</tr>
<tr>
<td>Warm Red</td>
<td>247</td>
<td>64</td>
<td>58</td>
</tr>
<tr>
<td>Red</td>
<td>205</td>
<td>32</td>
<td>44</td>
</tr>
<tr>
<td>Medium Red</td>
<td>198</td>
<td>12</td>
<td>48</td>
</tr>
<tr>
<td>Salmon</td>
<td>245</td>
<td>63</td>
<td>91</td>
</tr>
<tr>
<td>Pink</td>
<td>236</td>
<td>67</td>
<td>112</td>
</tr>
<tr>
<td>Rose</td>
<td>202</td>
<td>0</td>
<td>93</td>
</tr>
<tr>
<td>Ruby Red</td>
<td>224</td>
<td>0</td>
<td>93</td>
</tr>
<tr>
<td>Rhod Red</td>
<td>224</td>
<td>17</td>
<td>157</td>
</tr>
<tr>
<td>Purple Pink</td>
<td>195</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Dark Purple</td>
<td>87</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>Violet</td>
<td>75</td>
<td>0</td>
<td>161</td>
</tr>
<tr>
<td>Royal Blue</td>
<td>75</td>
<td>38</td>
<td>169</td>
</tr>
<tr>
<td>Medium Blue</td>
<td>15</td>
<td>35</td>
<td>149</td>
</tr>
<tr>
<td>Dark Blue</td>
<td>10</td>
<td>115</td>
<td>207</td>
</tr>
<tr>
<td>Aqua</td>
<td>0</td>
<td>115</td>
<td>207</td>
</tr>
<tr>
<td>Pro Blue</td>
<td>0</td>
<td>136</td>
<td>206</td>
</tr>
<tr>
<td>Grey Blue</td>
<td>101</td>
<td>189</td>
<td></td>
</tr>
<tr>
<td>Sky Blue</td>
<td>122</td>
<td>201</td>
<td></td>
</tr>
<tr>
<td>Apple Green</td>
<td>10</td>
<td>175</td>
<td>63</td>
</tr>
<tr>
<td>Forest Green</td>
<td>121</td>
<td>166</td>
<td>52</td>
</tr>
<tr>
<td>Grass Green</td>
<td>146</td>
<td>212</td>
<td>24</td>
</tr>
<tr>
<td>Lime Green</td>
<td>234</td>
<td>223</td>
<td>20</td>
</tr>
<tr>
<td>Canary</td>
<td>233</td>
<td>233</td>
<td>20</td>
</tr>
<tr>
<td>Gold</td>
<td>228</td>
<td>215</td>
<td>20</td>
</tr>
<tr>
<td>Dandelion</td>
<td>228</td>
<td>215</td>
<td>20</td>
</tr>
<tr>
<td>Burnt Umber</td>
<td>181</td>
<td>163</td>
<td>20</td>
</tr>
<tr>
<td>Dark Gold</td>
<td>193</td>
<td>187</td>
<td>20</td>
</tr>
</tbody>
</table>
ADDITIONAL PRINCIPLES
TIPS AND TECHNIQUES FOR DIGITAL BILLBOARD CONTENT SUCCESS

Start with a red, green, and blue color space, also known as RGB, the standard in digital technology. This is the same mode as your TV or computer. Cyan, magenta, yellow and black, also known as CMYK, unlike RGB, are used for high resolution printing. When creating content for digital signage, images must be created in RGB. Use the following tips to create files that work best for digital signage:

<table>
<thead>
<tr>
<th>Color Mode</th>
<th>File Size</th>
</tr>
</thead>
</table>
| **In Photoshop:**  
*To see if your image is CMYK or RGB:*  
- Look at the title bar.  
- The color mode is next to the file’s name.  
- The color mode should be RGB/8 bit.  

*Creating a New File:*  
- File > New  
- In Color Mode drop-down menu, select RGB.  

*Converting from CMYK to RGB:*  
- If the image has layers, you will be given the option of flattening your image when converting to RGB. The best practice if you already have a CMYK image is to finish in that color mode, then convert to RGB and flatten the layers when possible.  

**Note:** Colors may shift when converting from CMYK to RGB.  
- To convert a flattened image (1-layer), go to Image > Mode > RGB Color.  

**In Illustrator:**  
*To see if your image is CMYK or RGB:*  
- Look at the title bar.  
- The color mode is next to the file’s name.  
- The color mode should be RGB.  

*Creating a New File:*  
- File > New  
- Select RGB radio button.  

*Converting from CMYK to RGB:*  
- File > Document Color Mode > RGB Color

**To Check File Size:**  
- Under “My Computer,” identify the image you wish to check. Right click on the .jpeg image.  
- Click on “properties.” This will show the properties of the image you created.  
- The file size should be listed in the middle of the panel.  
- The file size should be around 70-150KB.

**In Photoshop:**  
*Compressing File Size:*  
- Open the file in Adobe Photoshop.  
- Choose “Save As.” Rename your file. Choose .jpg format.  
- A window will come up. Move the slider bar in the center to the left in order to compress the file size.  
- Use the “File Size” instructions, left, to view file size. If it is still too big, repeat the directions above.

**In Illustrator:**  
*Compressing File Size:*  
- Open the file in Adobe Illustrator.  
- Choose “Save As.” Rename your file. Choose .eps format.  
- This will compress the file size.

- Build content in its native measurement *(pixel by pixel - not inch by inch)* Example: 888 w x 260 h.  
- Save files as JPEGs.  
- 72 ppi is recommended for resolution for this technology.
IMPORTABLE IMAGE FILES

- Choose photos to import that have a smooth gradation (smooth change from one color to another) of color shades and don’t contain much detail.
- You may need to change the size of an image to fit your display and then crop it so it will look its best.
- For the most attractive images, use those in raster format (.jpg, .png, .gif, .bmp, and .tif) and set them at 72 ppi.
- Logos appearing on a black or colored background will be more effective than logos on a white background.

IMAGE FOR DIGITAL ADVERTISEMENT

FOCAL POINT OF THE IMAGE

Tip
Add interest—show only a portion or the focal point of an image. Examples above.
EXEMPLARY OF DYNAMIC CONTENT

Dynamic Content is defined as the ability to automatically update data within a creative template utilizing a RSS feed.

Interact with audiences by displaying interactive content, such as time and temperature, the artist and song on a featured radio station, hospital ER waiting times, and live feeds. Talk to your Daktronics representative about our dynamic content options.

CREATIVE TEMPLATE

CREATIVE TEMPLATE WITH DATA